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Introduction to BusinessObjects 4.1

This guide highlights the basic functionality of the BusinessObjects reporting tool, as well as
the differences between version 3.1 and the newly redesigned version 4.1. Most functionality
remains the same, but the visual representation is slightly changed.
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DEFINITIONS AND REPORTING STRATEGY OVERVIEW

Components for Reporting

(overnight refresh)

) Opcrational
Colleague Data Store

Universes
(Reporting Fields)
‘ [

Web Intelligence Documents
(Reports) o

InfoView Portal / Bl Launch Pad
(User Interface)

Definition: Operational Data Store (ODS)
A separate repository from the main Colleague database that contains a snapshot of
Colleague data captured at a given point in time and updated each night.

Definition: Universe

Universes hold select metadata from the Colleague database and make data fields
("objects”) available through web reporting tools such as BusinessObjects. Universes include
fields from the major Colleague applications (Student, HR, Finance, Core, Financial Aid, etc.).

Definition: Web Intelligence Documents (Reports within BusinessObjects)

A web-based query and analysis tool providing drag-and-drop functionality that allows you
to view a report’s structure and underlying details, filter information, and create and position
new tables and charges.



DIFFERENCES BETWEEN INFOVIEW AND THE BI LAUNCH PAD

InfoView vs. Bl Launch Pad

InfoView (or, the BusinessObjects 3.1 portal), a web-based portal for accessing Web

Intelligence documents (and many other things), is now called the Businessintellignece (BI)

Launch Pad.

Information about how to access the new Bl Launch Pad is provided by the Colleague

Computing office.

Home Screen

InfoView's Home screen showed a general folder structure and links to documents,
favorites, and inbox folders, as well as a link to account preferences:

&7 Home | Document List | Open - | Send To - | Dashboards -

Help | Preferences | About | Log Qut

Navigate

View your Inbox, Favorites, or Document Lists. Use the Help to learn
more about InfoView.

Document List
£l My Favorites
[5 My Inbox
k5 Information OnDemand Services

@ Help

F X

Welcome: instructor

Personalize

Change your InfoView start page, viewing options, and preference
for daily tasks.

Preferences

The new Launch Pad Home screen shows recently viewed and run documents, as well as
unread messages in a user’'s inbox. Documents and reports are now displayed in tabs

across the top of the screen, which a user can switch between at any time.

Home l Documents ]

~ My Recently Viewed Documents

#| Basic Person Demographics

| RPT_AR Qutstanding Balance for Past&...
| RPT_AR Qutstanding Balance for Past&...
¥l RPT_AR Enrolled Without Invoices

¥/ RPT_AR Complete Withdrawals Before 1.
| RPT_AR Cashier Session Recondliation ...
#| RPT_AR Cash Receipt Details by Term

| RPT_AR Account Analysis by AR Code 1...
¥| RPT_AR Account Analysis by AR Code

#| RPT_AR 1098-T T9TG Savediist Report

- My Recently Run Documents

Q InfoView Test Report

~ My Applications

0

~* 0 Unread Messages in My Inbox

Mo unread messages

W’

<

See Mare...

~ 0 Unread Alerts

Mo unread alerts




Document List

InfoView: The reports you can access are structured in folders and sub-folders (similar to

Windows Explorer).

&= [ Public Folders

7 Administration Tools
- Auditor

- pashboards

H
H
{11 patatel Sample Reports
t]

s OO s JOUOO s OO

-l Datatel Sample Reports - Release 1.1
I Diagnostic Test Folder

-7 Feature Samples

7] Performance Manager

sl
L

[ Report Conversion Tool

rn]
)

L) Report Samples

I Search Program

|7 B | & | New - Add - | Organize - | Actions = | Search title ~ | £ |
=8| Title

B 55 My Favorites My Favorites

- £ mbox Inbox

Public Folders

M

s

4 [1_Jof1 »

Launch Pad: On the Documents tab, reports are now separated into personal and public
categories. To see your Favorites and Inbox folders, click on "My Documents.” To see
Public Folders, click on “Folders.” To search for documents, click on “Search.”

IHome Documents Home | DDC“'“E“E]
View * MNew v Organize Send More Actions View ~ Mew ~ Organize Send More Actions
My Documents My Documents
1 mebinteligence E Public Folders ?
- B At E
I Institutional Research Heng .
¥ 53 pashboards
""" ) Reports on Hold
“ E Inbox | Data Federation
&E My Alerts
Home | Documents
j Subscribed Alerts
@ Personal Categories View MNew Organize Send More Actions
Folders My Documents
Categories Folders -
Er ‘ Categories
Search
o




Preferences
In InfoView, the best view and editing tool was “Interactive” since no downloading was
required. In Launch Pad, use “Web" instead.

InfoView

Preferences - Administrator

¥ wWebh Intelligence

Select a default view format:
@ Web {ho downloading required)
@ Interactive (1o downlozding required’

@ PDF (adobe AcrobatReader required)

Wdbien viewing & docurmert:
) Use the document locale to format the data

@ Use my preferred viewing locale to format the data

Select a default creation/editing tool:
O advanced (Java 2 required)

@ Interactive (1o downloading required)

) Desktop (Wb Intelligence Rich Cliznt required) | Install Now

) weh accessibility (502 Compliant)

Launch Pad
- Breferences Web Intelligence
General View

Change Password @ Web {no download required)

Locales and Time Zone ) Rich Internet Application  (down =l -'5::
= Desktop (Windows only) (installation required]
Analysis edition for QOLAP _ POF

Muodify (creating, editing and analyzing documents):
This is also the interface launched from the Go To list or My Applications shortcut.
@ Web {no download required]

BI workspaces
Crystal Reports

(7 Rich Internet Application (download required]
{® Desktop (installation required)

Select a default Universe:

Mo default universe | Browse ...




Opening Reports
Functionality remains the same. Right-click the report title and select “View".

InfoView Launch Pad
Basic Person Demographics W
L|pd ated PerE.‘I"tiE.‘S | | Organization Basic Demogra;
View Latest Instance
What is . ed name, addres )
: Categories . Properties
Organiza : ohics Modify
U[JdEItEd Modiﬁr Schedule
What is ed name, address i
Schedule History
Histor*_.r Categories
N Document Link
2w ]
MNew >
Add v .
Organize >
Organize  » Send >
Details

Opening Multiple Reports

In Launch Pad, you may open multiple reports in the same session. Use the tab structure at
the top of the screen to navigate between your home tab, documents tab, and any open
report tabs. This functionality does not exist in InfoView.

| Home | Documents | Basic Person Demograph... Il}rganizaﬁnn BasicD... & # ||

Home | Documents | Basic Person Demograph. .. l Organization Basic Demo... l




Responding to Context Prompts
Context prompts look slightly different in Launch Pad. Instead of a solid blue bar to indicate
the selected option, you must now place a check box in the context(s) you wish to use.

InfoView

Contexts x

Select contextis) for the gueries.'Basic Person Demographics

A Cucry 1.Context 1 Acad Credentials Majors Minors

Use All Addresses for Person

Use Preferred Address for Persan

Context description:

(7} More Information

To avoid ambiguties in a guery, contexis may be used to implement restrictions on how the objects can be
combined. You need to select which context corresponds te the type of information you want to return to -

[ Applycontext || Cancel

Launch Pad
Query Contexts ,c
Context Selection

Select a context for Query 1

|| UseAll Addresses for Persen
LUse Preferred Address for Person

Description:

Ok Cancel




Responding to Report Prompts

The format of report prompts has changed from a top-and-bottom panel to a left-and-
right panel in Launch Pad.

InfoView

Prompts -

Reply to prompts before running the guery.

Enter Person Full Name {use "%’ for wildcards): A%

Enter Person Full Hame (use "' for wildeards):

A |

(7} More Information

Select or type the values you want to return to reports for each prompt displayed here.

[ Runauey ][ cancel

Launch Pad

Prumpté St.rmmanf

v

kbbb

RunQuery | Cancel




Navigating Report Results
Launch Pad now utilizes two different toolbars to navigate through the report, zoom,

refresh, etc. InfoView has only one main toolbar at the top of the report, while Launch Pad

has one on the top and on the bottom of the report. Hovering over icons will provide
descriptions of the buttons.

InfoView
Web Intelligence - Basic Person Demographics afx
‘¢! Document ~ View ~ | [ 15[ 43 | @ v .f1 Edit | 2 RefreshData =X | [f Track 7 4% | &% | O}

Launch Pad (top)
DeEE-1 Sk

Launch Pad (bottom)
[:& Track changes: Off

-
&= o e o

[« Track = ' Dril = "% Filter Bar BH Outline

M 4 pagelofi+ F M =2 7 minutes ago

Viewing the Document Summary

ltems such as Document Summary appear on the left side of the screen. The buttons to
toggle between item options now appear at the top left in Launch Pad instead of at the

bottom in InfoView.

InfoView Launch Pad
Document Summary B " nen
& Print — 7, print
= General i %E i i =
Documant name: Basic Perzon Demographics : ‘ﬁ Basic Person Demographics
Creator; Administrator i J
) . - |~ General
Last modified by: Administrator I
Description: Updated for 1.1 - What is the name or preferred ()| | Thoe: Web Inteligence document
name, addres — | Author: Administrator
:hgﬁf‘:‘g'&f“””&' LT IR TS Creation date: February 28, 2008 5:54:49 PM GMT-05:00
son? Address type selectable Locale: English {United States) E
Kengrds; gender phune DE.‘S‘GE‘Z’J‘F‘O."‘J.‘ Updated for 1.1 - What is the name or -
Document lpcale: English (United States) 'pLifﬁ;reedmZ‘;m:H:gg;e;i;:?nefgf;;rﬁon -
Creation date: February 28, 2008 5:54:4% PM GMT-05:00 bt ok
Last refresh date: September 30, 2010 10:32:40 AN GMT-04:00 Kepwords:
=l Document Properties
Enhanced viewing mode: Off * Statistics
FEERNETITES or Lastrefreshdate:  April 3, 2014 1:09:05 PM GMT-04:00
Permanent regional formatting: Off :
- Last modified: May 16, 2013 10:06:43 AM GMT-04:00
Use query drill: Off E &
Always merge dimensions: On Last modified by: Administrator
Track data changes: Off Duration of previous .
Auto-update reference data on On refresh:
refresh: ~ Document Options
Enfhianced viewing:  Off
= Prompts
/" Enter Perzon Full Name (use B% Refresl on apen: On
"0 for wildcards): s Permanent regiona’  Off
formatiing:
=3l I== -
’E' i = 2 B ﬁ *[C ﬂ‘ﬁ Lise guery drill: Off -
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Viewing the Data Summary

The Data Summary is no longer available in Bl Launch Pad.

InfoView

Data Summary
3 Print

[=/ Data source
= Query 1
Universe: Colleague Core ODS R1_1
Last execution time: 1s.
Nb of rows: 31

=l Objects
= Query 1
Person Address City The text name of the city in the address. [Source:
CITY]

Person Address The text name of the country for this address.

Country Desc [Source: CTRY .DESC]

Person Address Line The first line of the street address. [Source:

1 ADDRESS.LINES pos 1]

Person Address Line The second line of the street address. [Source:
2 ADDRESS.LINES pos 1]

Person Address State The text name of the state. [Source: ST.DESC]
Desc

Person Address Zip  The ZIP code for this address. [Source: ZIP]

Person Citizenship The text description of the individual's country of
Desc citizenship. [Source: CTRY.DESC]

Person Ethnic 1 Desc  [Source: PERSON.ETHNICS valcode]

Person Ethnic Desc ~ The text description of ethnic category of the
inidividual. [Source: ETH.DESC]

The individual's name in a standard Last Name,
First Name format. [Source: LAST.NAME,

Person Full Hame

»

m

P EEEEE

Viewing the Document Structure and Filters

You must be in “Design” mode in order to view Document Structure and Filters in Launch
Pad. Design mode will be covered later in this document.

InfoView

Document Structure and Filters

Filter Remove Format

= Qj Basic Person Demographics
= (7 query 1

Perzon Full Name Matches pattern
" AND| prompt{Enter Person Full Name
(u=e "%’ for wildcards)")

= =] Report 1
Page Header
= Page Body
] Cell: ="Basic Person Demographics”
™ Vertical Table: Blocki

|E| Page Footer

4|

[ Cell: ="SAMPLE REPORT: Thiz report is prov

Launch Pad

=

Filter | Axis

= _}j Basic Person Demographics

ER= Jreport |

(1)

[H] Page Header

[] ="Basic Person Demographics”

™" vertical Table : Blodk1

[] ="SAMPLE REPORT: This report is provide. ..
[F] Page Footer

EELEEEEE

11




Viewing and Resetting the User Prompts
Switch to User Prompt Input to view the prompts completed when the report first ran and

to enter different values to rerun the report.

InfoView Launch Pad

User Prompt Input s

(7] Advanced | 5 Run

(7 advanced | = Run

1 Enter Person Full Name (use '%' for wildcards):
Enter Person Full Hame (use "%" for wildc Bo,

|B% | W

el

14 | 1] | b

B3 Ey oy “@*E“EI%

Finding Data

Switch to Find to use search functionality to locate specific data in the report results.
InfoView has the Find option in the left panel. Launch Pad puts the Find option in the top
toolbar, and the search field appears directly below the report results.

InfoView Launch Pad
Find . — -
el S &®a-m=-
Find:
[Brown | | Find Next
Opticnzs
i 0000400 | Erik Erik Bennett M Black, Mot of
[C] Match whole word 0000409 Baig, Muhammad MuhammadBaig M Asian Or Pa
[] Match case !
£l UL
Direction B . l -
@ Up Find:| Bennett # - | - FindMext - FindPrevious  (£)Found matches on current page
i@ Down
B3 By o = B B L)

12



Closing Reports

In InfoView, close the report by selecting Document = Close or by clicking the "X" in the
upper right corner. In Launch Pad, simply click the “X" on the report tab.

InfoView

Launch Pad

- Ducurnent|v| View - | E &‘ | % ||

||'k:1TrE|Dﬂ¢:Lrna1t5 Basic Person Demog... -~ -I:I@L

Close ||
i

Edit

= [x
| o |

Copying an Existing Report

To modify an existing report, you need to make a copy and place the copy in your "My
Favorites” folder. Begin by right clicking on the report and choose Organize - Copy.

InfoView Launch Pad
Title “ Last Run Title «
Academic Credentials for P
|  Academic Credentials for Persons B | Academc Credentias for Fersons

Updated 1.1 -
wWhere did each person graduated from ar

J2rmograpnics

Properties

¥ Organization Basic Derograp  YIBW
Updated for 1.1 - Categories
what is the name or preferr  Scthedule
History
Tenar v
Add v

Create Shortcut

View

| | Organization Basic Demographics
View Latest Instance

Properties
Schedule

History
Categories
Document Link

Create Shortcut In My Favorites
- > [
Detais Copy Shorteut

To store the copy, right click on your “My Favorites” folder and choose Organize - Paste.

_/nfoVieW

Add v

" 0 AR Sample FHepor

Launch Pad
My Documents
Gl 1) Favories
Properties
1 ~ebin Pe
Mew >
2, Inbox
68 Oz e
My alerts
Details
|£ Subscribed ¢
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Launch Pad: Reading and Design Modes
Launch Pad has two different modes: Reading and Design, which you can access in the
upper right hand corner of the report screen. Reading mode will allow you to refresh and

view the report only.

Design mode will allow you to make formatting and other design

changes to the report. Note that additional formatting tabs will appear once you switch to

Design mode. InfoView does not have different modes for reading and design.

Reading Mode

HomeIDocuments 'Basic Person Demog... +~ = K l
Dl - S3@ L3 0 e

Web Inteligence ~ [& Track ~ ' Dril = ' Filter Bar & Outline | | Reading| ~ Design -

Design Mode

[Home IDocurnents I Basic Person Demog... .= = l

File | Properties | Report Elements | Formatting | Data Access | Analysis | Page Setup |
OG- S| 50 2 - = ~|| ~ Tables | €l |7 Gection | " Chart | Other | " Took | Posiion | Linking

o6&k BB|IX| - B-E-8-8- T Tum Into

Reading 'I Designl'

i
=4 | Set as section

Changing Formatting
= Highlight the object you would like to format.
* InfoView: Use the Formatting toolbar to change as needed.
» Launch Pad: Click on the “Formatting” tab and change as needed.

InfoView
Arial -2 |-lB 7 UJA- &k E==1= =2 = 7
Available Objects
! SAMPLE REPORT: This report is provided as a template and is meant as a reference for your report devel
nsert Merge H report's fitness for use may vary depending on your requirements and your data Make any formatting an
needed and verify the report Iic and output in your environment before use.

= Available Objects
Person Addres
Person Addres

Basic Person Demographics

Launch Pad

Report Elements | Formatting Data Access | Analysis | Page Setup |

Font | Border |~ Cell " Style | Numbers Alignment | Size | Padding  Took ||
Arial e -l e s A S-OIIE====2 || & %

fic mi’ 3¢ . | ="Basic Person Demographics”

s i s
ut in your environment before use,

needed and verify the report logic and out

SAMPLE REPORT: This report iz provided as a template and i= meant as a reference for your report developme
report's fitness for use may vary depending on your requirements and your data Make any formatting and de

Basic Person Demographics

14



Adding Objects
= Display the Available Objects.
= Click and drag the appropriate object into the report.
InfoView
Available Objects

SAMPLE REPORT: This report is prwideda]
Insert | ) Merge | =4 variable - report's fitness for use may vary dependin
needed and verify the report logic and outy

= [ Available Objects

! Person Address City

! Perszon Addrezs Country Desc
! Person Address Line 1

J Person Address Line 2 T ———

[om ] »
m
o]
8
0
0

! Perznn Fthnir 1 Nezr 0000018 Burl 4 person Address Zip Fl
< | m | » 14| mo I
A E PR | Report1 |
Launch Pad
[a Available Objects ~ U fic mit x| =Basic
Type here to filter tree
E SAMPLE REPORT:
= ﬂ Basic Person Demographics report's fitness fq
=5 = [ Query 1 needed and verify
=0 ! Person Address City
! Person Address Country Desc
E ! Person Address Line 1
! Person Address Line 2
Eﬂ ! Person Address State Desc
1 Person AFEEE |'J- N S - - Person Address EEIEr
I_j ! Person Citizenship Desc Person i a
| Person Ethnic 1 Desc
Q000010 Bot
! Person Ethnic Desc
! Person Full Name 0000020 Bar




Removing Objects
Right-click the column.

InfoView: Select Remove = Column
Launch Pad: Select Delete

I Add - :erson Full :erson Preferred Person Full
erson ress ZijName ame Person Address ZilName

Set as section Ms. Kathleen Burge
22033 Insert » [Ms. Peggy Burns
Format » |Ms. Cynthia Braun 07047 R
[T} Paste Ctrl+
54304 Filter y |Miss Elizabeth Bead 07002
Insert L4
75745 Turn table to_. Mr. Jack Bell 07305
Ix Delete
22022 Swap axis Ms. Margaret Best 07093 -
14 Merge
» 07304
30642 Break Mr. Steven Bartkows ST
80917 Sort * |Dr. Vincent Bia 07030 - )
T R lgj Set as section
alculation 07306
94301 Mr. Jeremy Berg T 5
94301 Hyperiink » |Ms. Laura Berg e Sr——
95124 Order » |Ms. Betty Bright e Linking )
93104 Align ¥ IMs. Lucy Brown 07030 3 Dl 4
93813 Remove 4 Row FEEEE 7 Filter 3
07307
97843 Braun, Jeffrey Column il Ranking »
TN Onhhid Manhs Table 1 07002 -%l Sart »
I
07002-1518 = Bresk 5
BEEEEEI T 1de b
ALibe e ) Formatting Rules ]
Text L4
Alternately, highlight the column you wish t Format Cell... data under

the column header.

InfoView: From the Report Toolbar, click the “X" button and then select

“Column”

Launch Pad: Click the “X" button under the “File” tab.

InfoView Launch Pad
b2l .| V- |=E QJ%* - | TE - L/File|fPrnperﬁes| " Rep
it fe W XK |[F‘er5|:|nID] Nl S P82~ Filten
| Available Ohiects | Column = e ok m|lx] - ” Filtd
= Type here to filter re| Delete the Selected Report
o Elements

16



Sorting Data
= Right-click the column you wish to sort.
= Select Sort - appropriate sort order.

InfoView Launch Pad
Person Dere o Dere Dere
Person Ethnic Citizenship Person Status Person Ma De De De De
Desc Desc Desc Status Desg
K cut Cirl+x
Set as section Copy Ctrl+C
(White, Mot of Single
' [ Paste Cirl+v
Insert b White, Not of single
Insert » )
Format » Unknown X Delete Married
White, Non-Hispa ey , Widowed White, NOtof! (1 1verge Single
Black, Mot of Clear Contents Single
Turn table to... White, Not of | - )
Set as section
S"'-‘-"EF: axis CIENAEEET Turn Table Into 3 STE
. Black, Mot of EditF I Single
Race / Ethnicity U Break b Unknown ) L rOrmu. )
[Asian Or Paci Linking v Single
QOther Asian |5'3”'t H|¥ MNone White, Notof| — |, , single
Calculation H % Ascending Asian OrPaci . 5
z . Black, Mot of - Single
Hyperlink b| i+ Descending L
4+ Unknown ‘;l Sort 13 I Ngne
Order b|Fy Customsort. White, Not of == greak v| &1 ascending Cirl-+alt++
Align » Remove Sorts Black, Not of | % de » | Z| Descending Cirl+Alt+
. Other Hispan Formatting Rules » Remove all Sorts
White, Non-Hi R v Properties R
e, Non-R1sps EMmoveE T I 4 Text » Manage Sorts...
Report Format Cell... |

= Alternately, select the column you want to sort by clicking on the data under the
column header.
» |InfoView: From the Report Toolbar, click the Sort button and choose the
appropriate sort order.
» Launch Pad: From the Analysis Tab and the Display sub-tab, click Sort and
choose the appropriate sort order.

InfoView Launch Pad
Lo~ ||ﬂéll ‘- |=E| = 4 " Data Access Analysis | Page Setup | Readi]

Availabl| ¥ Mone

Display |l Conditional | Interact | Functd

Insert | 2| Ascending

nput Controls ~ || °= Break + || 4] Sort - ¥ Dl ~ % Filter

A f Descending
4 Person Ethnic Desc] +  Mone
7y, Custom sort...
4] Ascending Cirl+Alt++
Remove Sorts - i
0 2| Descending Cirl+Alt+-

Properties

Remove all Sorts

Manage Sorts...

17



Breaking Data
= Right-click the column on which you wish break the data.
= [nfoView: Select Break—> Insert
= Launch Pad: Select Break - Add Break

InfoView Launch Pad

Person [T
. " . Person Ethnic (Citizenshi Pers
Person Ethnic Citizenship Pel Person Gender  |Desc Desc d Dest
Person Gender Desc Desc De:

F i
Set as section F i e United States
F Copy Cirl+C
Ingert L4 F [ paste sy |United States
F M United States
Insert »
Format k F
F x Delete
Fitter » F B Merge United States
M T e M Clear Contents United States
urn tamie 1o... i
F ] @ S — United States
Swap axis 1 T , | United States
] :
M Break » Inzert Edit Formula. .. :
M F Linking y | United States
» .
Sort Properties 1 5 ol N
M Calculation J F = Fiter , |United States
. M m: Ranking 3
F Hyperlink k M A] sort » | United States
F Order » F - Break M= AddBreak
F T Hide b (= Remove Break
F Align b F Formatting Rules » Remove All Breaks
M Text 3 Manage Breaks...
M Remove 3 | “anad
F Format Cell... l United States

= Alternately, select the column you want to break by clicking on the data under the
column header.
» |InfoView: From the Report Toolbar, click the Insert Break button.
» Launch Pad: From the Analysis Tab and the Display sub-tab, click Break and
choose Add Break.

InfoView Launch Pad
A = o — - Formatting | a Data Access Analysis & Page Setup |
WIEESEIEE .
king | Display | Conditional |
nking = | =8 InputControls = ||| == Break - | %] sort -
F |=[Pv.=_-rsur1 Gender] ||:§ Add Break
' == Remove Break

Person Ethnic Remove All Breaks
‘erson Gender Desc

Manage Breaks...




Applying Quick Filters: InfoView
= Right-click the column on which you wish filter.
= Select Filter > Add Filter.
= Complete the dialog box.

Filter x
Person Marital Person Phone Person Phone Person Ph
Status Desc Number Extension Type Desc
Set as section Person Marital Status Desc
o N Single, Never Married
Unknown : = "_, .
Format 4 Widowed | Person Marit... | Equalto -
Widowed = == :
Fitter Ml Add Filter
Turn table to... X Remove Fiter "
£
Swap axis - £
Unknown Break »
Home /Pe
»
St Enter your search pattern here |aﬁ -
Calculation 3
Hyperink 5 [_"?_.} More Information
Order N Select or enter the the values that you want to show on the selected table or cell
Align 3 ] [
; oK Cancel
Smge,NeverMal] Remove v

Applying Quick Filters: Launch Pad
= Right-click the column on which you wish filter.
= Select Filter > Add Filter.
= Complete the dialog box.

Report Filter x
Person Marital Person Phone Person Phone Person Phone 3 Filter On Block1 T AddFiter ¥ T | - -
Status Desc Number Extension Type Desc
f ]
I——‘ ! Persan Marital Status Desc | Equal to | Married
X cut Ctrl+¥
& copy Ctrl+C
Single
[B Paste Ctrl+v
Single
] Insert 4 It Person Marital Status Desc Equal to
X Delete Person Marital Status Desc lezal [Married
Single _T
7 by Merge Single <
Single
Clear Contents
) ﬁj Set as section
Single
Turn Table Into »
Single
Edit Formula. ..
Single | o8 -
Linking 3
Single
Drill 3
Filter 'I  Add Filter 2 T
Single ) — o || cancel || appy
Ranking » | F EditFilter
Sort » [ ¥ Remove Filter
Break 4 Filter by a New Input Control
Hide 3
Formatting Rules >
fiamed Text 3
AR Format Cell...
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Within the dialog box, you can even add or remove additional filters.

Report Filter

»» Filter On Block1

Person Marital Status Desc
Married
Single

' Person Marital Status Desc | Equal to

= )j Basic Person Demographics
! Person Address City
! Person Address Country Desc
| Person Address Line 1
| Person Address Line 2

Available Objects

! Person Address State Desc al to

! Person Address Zip

! Person Citizenship Desc
| Person Ethnic 1 Desc

| Person Ethnic Desc

! Person ID

m

! Person IPEDS Race Ethnic Description

| Person Marital Status Desc

| Person Phone Extension

! Person Phone Number -

OK Cancel

CK Cancel Apply

7 AddFiter |'F T | « ~ |

= Alternately, select the column you want to break by clicking on the data under the
column header.
= From the Analysis Tab and the Filters sub-tab, click Filter and choose Add Filter
and complete the dialog box that appears.
Report Elements | Formatting | Data Access JI/ Analysis || Page Setup |
]

Eiters || Data Tracking | Display | Conditional |

7 Filter = | AL Ranking ~ | ZE InputControls ~ || = Break ~ | %] sort -

7 Add Filter srson Marital Status Desc]

F Edit Filter

L. ¥ Remove Filter

Filter by a Mew Input Control

20



Adding Aggregations

= Right-click the column on which you wish to add an aggregation.
» |InfoView: Select Calculation = appropriate aggregation.
» Launch Pad: Select Insert - appropriate aggregation.

InfoView

Qoooo1s e urger, Kathleen Ms.
0000022 nsert 5 aurns, Pegay s,
Q0ooo3g Format 5 graun, Cynthia Ms.
0000046 ] Beachtel, Elizabeth Misg
Fitter 3
0000191 Turn table fo._ Bell, Jack Mr. J
0000194 Swap axis Hest, Margaret Is.
0000212 Break » Bartkowski, Steven Mr.
0000223 Sort ¥ Hia, Vincent Dr.\
0000240 Calculation » Sum
0000241 Hyperlink #| 11 Count
0000242 Order » AVErage
0000243 Align | X Min
=, Max
0000244 Remove 4
Percentage
0000347 97843
Default
MNNN2 7N e e 1 e e ]

Launch Pad
b e
Person ID Name Name

10 & cut cul+x Botros
0000020 Copy Cirl+c Barret-McBurre
0000296 [ Paste cul+y Entley F
0000314 I Insert PI % Rows Above
0000332 X Delete E., Rows Below
0000338 Fid Merge T Columns on Left
0000358 Clear Contents M* Columns on Right
0000380 lﬁj Set as section I T Count
0000387 Turn Table Into b | Min
0000400 Edit Formula. .. <A Max
0000409 Linking » 1mad Baig M
0000417 3 Dl » ruzzese F
0000433 7 Filter » ros Boulis I
0000438 ik Ranking » Saah F
0000440 2] sort » itarseh M
0000441 = Bresk * Batarseh M
0000454 “F Hide * zaupin F
0000504 Formatting Rules » |a Brett F
0000525 Text ¥ leiro-Louro  F
0000545 Format Cel... | Barthel M

= Alternately, select the column you want to aggregate by clicking on the data under
the column header.
» |InfoView: From the Report Toolbar, click the Calculations button and select

the appropriate aggregation.

» Launch Pad: From the Analysis Tab and the Functions sub-tab, click the button
for the appropriate aggregation.

InfoView
b gl .| ¥ -] =E m-| X -~

Available Objects —_—

Inzert Merge | =i varid 21__Count

[=l [f | Available Objects FIIEIELE
| Person Address City | <X Min
| Person Address Cour A Max
| Person Address Line
| Person Address Ling Percentage
| Person Address State
4 o P . Default

Launch Pad

" Data Access LI Analysis

g Page Setup |

Reading = Design -

" Display | Conditional |

hput Controls -

Interact Functions I

- Break - %l Sort -

¥ Sum ‘H Count ore T
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Inserting New or Duplicate Reports

= Right-click one of the report tabs.

» |nfoView: Select Insert Report (for a blank report) or Duplicate Report (for an

exact copy).
» Launch Pad: Select Add Report (for a blank report) or Duplicate Report (for an
exact copy).

InfoView
OOOETE S e |
Rename Report
0000223 a(
Inzert Report
0000240 g
Duplicate Report
0000241 94 o
Liglele Heport
0000242 85 o
ove Repon F
0000243 81 .
L Drill Mode
oo00244 93
Show changes
0000347 g7
Format Report
MNNa27n 3] |
il Sawve to my computer as kL
|| =| Report 1
Launch Pad
(RRNaNINES T | Odldi oIl Tdlica rdiecs Oodidli=g
0000454 Add Report Cirl+Shift+R
0000504 | 2 Duplicate Report
et F=Thi LT =} BreirT
0000525 | % Remove Report
00o0s45 Rename Repaort
0000860 Move Report »
0000561 Export Current Report As k
1 | I Format Report...
Report 1
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Creating Variables: InfoView

= Switch to Available Objects.

= Select Variable - New.
= Complete the dialog box.

Available Objects

Create New Variable

Name:

Type:

Person Count

Number

Qualification:
Measure

Formula:

=Count{[Person D]}

Validate

Available Objects

Available Functions

Available Operators

Ingert Merge
[= [1| Available Objects A = Al | = e
= [ Available Qbj | Person Address City |= | Abs. BETFEEEEh
| p A | Person Address Coul Asc Al A
Er30n A4 f Edit ! Person Address Line Average And =
] Person A4 B ! Person Address Line BlockName Botwicin
| Person Ad Edit Properties | Person Address Stati ™ Ceil ~ | Biock
4 [T | G 4 m b e =
| Person Ad Remove M =
| Perzon Address State Desc I
| Person Address Zip
| Person Citizenship Desc =
) | 2} More Information
| Person Ethnic 1 Desc - .
2 e variable, then type t 8 text box i
4 | I | 3 o treat the variable as a ail. Va -
@Eﬁ@l"l@ﬁﬂfa‘a ok
Creating Variables: Launch Pad
= From the Data Access Tab and the Data Objects sub-tab, click New Variable.
= Complete the dialog box.
Create New Variable T
Definition
Nenee
|Person Count
Qualification:
| Measure T
Formula
| =Count{[Person I0]) |+ |
| X
Available Objects Available Function.s- B Available Operators
=2 jjBadc Person Demograp “ || = [ Aggregate || e | i ] [ =
dress Cit Aggregate , PO N T
Report Elements | Formatting Data Access Analysis | Page Setup | [dress Col= AuETage: = {
dress Lini Count L[] 5 i
N - dressLini | frst ; |E |
# Data Providers /| Data Objects 4 Interpolation I =
ress Stz Last 3
: = - | = - L ' i - d dress Zip Max After
t'ﬁ Edit Purge = Refresh = Mew Variable Merge sl i Al
7 Person Ethnic 1 De: Min QHEO
! Person EthnicDesc _ Mode B:f‘o:z After
P NPT Percentage i
[ il | r Percentile. | oetveen =
Description
Person ID

Unigque Colleague identifier for a person within the system  [Source: ID

—_—

Cancel
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Inserting New Tables: InfoView
= Switch to Chart and Table Types.
= Click and drag the appropriate type of table into the report.
= Add elements to the report as needed from the Available Objects.

Chart and Table Types

Insert

These elements are available to drop into your

report
=l Report Elements to Drag and Drop “n
(= Table Elements |E b
Horizontal Tabl = sas i
orizontal Table _ﬂ-*| “Vertical Table
= Form
[= Chart Elements - || 4 1}
@ Effm]= & @ & |2 Reportz

Inserting New Tables: Launch Pad
» Select the Report Elements tab, then the Table sub-tab.
» Click on the type of table you would like to insert.
» Click in the space where you would like your table to appear. A blank table will be
added to the report.
» Drag-and-drop fields from the Available objects into the table.

_/ Report Elements ' Formatting | ' Data Access |

Tables Ceﬂl S-Bcﬁnnl Chart Other
ZlE-B- E-|i-%-0-

|_ Click to insert the table here (Press ESC Key to cancel this a-:tiu:un:l|

-!_-E f\: & W

:Tr;e here to filter t
E = )j Basic Person Demographics
= [= = Query 1
=0 i Person Address City

1 Person Address Country Desc

f'.’_1 { Person Address Line 1 T Lm_
- J Person Address Line 2 ey

’ S ! Person Address State Desc _a Ll
| 1 Person Address Zip

J Person Citizenship Desc

J Person Ethnic 1 Desc

{ Person Ethnic Desc

4 Person Ful Name o

“Brerson Genderji




Converting to a Different Table Type: InfoView
= Click and drag the appropriate type of table.
= Drop it over the existing table.

Chart and Table Typez

Inzert

These elements are available to drop
into your report

=l Report Elements to Drag and Drop
[=] Table Elements

I_ Horizontal Table | California
Vertical Table . .
— 4 California
=  form ——— m‘
Chart Elements 1 .
o Georgia
Minnesota
Yirginia

i
I

E
I

!
M

Person Address SiPerson Gender _|Person Count

3
3

4

-] &

Converting to a Different Table Type: Launch Pad
= Right-click within the table.
= Select Turn Table Into = select desired type of table.

Person Addr Person Gend Person Coun

Arizona 1
. .

California = 4
—— Cut Ctrl+%
California 1

Copy Ctrl4C
Colorado ._ﬂ] T Cirl+V 1
Connectic Insert v 1
Delaware| X Delete 1
Florida :Ej Merge 5
Flaorida Clear Contents 2
Florida %j Set as section 1
Georgia Turn Table Into r Horizontal Table |

Edit Formula. .. Cross Table
Maryland 'E-l
Linking » Column Chart

Maryland u

3 Dl b | %% Line Chart
Massachy

¢ Filter b | N Pie Chart
Masszachy i

cih Ranking ¥ |ED} More Transformations... Ctrl4Shift+T
Michigan 4] sort p T
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Swap Axis: InfoView
»= Right-click anywhere in the table.
= Select Swap axis.

A

v ==

Insert 4
Format 4
Fitter 4

Turn table to...

Swap axis

Break k
Sort 3
Calculation L4
Hyperlink 4
Order L4
Align [ 3
Remove

Swap Axis: Launch Pad
» Drag one of the row values on top of one of the column values (or vice versa).

California Colorado

=[Person Gender] Arizona

4 California 4
1 Colorado 1




Inserting New Charts: InfoView
= Switch to Chart and Table Types.

= Click and drag the appropriate type of table into the report.

= Complete the dialog box (may vary by chart type).

Chart and Table Types

Insert

These elements are available to drop into your|
report
=] Report Elements to Drag and Drop
Table Elements
[=] Chart Elements.

= 3
[.l Vertical Grouped|

g \ertical Percent
Horizontal Percent
4l 30 Bar

(il Wertical Bar & Line

o
¥ [ =

Horizontal Grouped :
11 vertical Stacked [l vertical g
E- Horizontal Stacked

4

| E" Horizontal Bar & Line
B EHm= e R

By Report1

Available Objects

& [ Available Objects
[ [ | Variables

() Z-Axis (Optional}

@ Wore Information

Modify the relationship between data and chart axes

Inserting New Charts: Launch Pad

= Select the Report Elements tab, then the Chart sub-tab.

= Click on the type of chart you would like to insert.
= Click in the space where you would like your chart to appear. A blank chart will be

added to the report.

Report Elements Formatt'ng| Damm:cess|
Tables | Cell |~ Section | Chart | Other
m-i-g-e-[wlv-o-

m Click to insert the chart here (Press ESC Key to cancel this acﬁun}|

Drop data objects here

All Measures
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» Drag objects to the X-axis and Y-axis from the Available Objects.

ailable Obje F A)&J|
Type here to filter tree
=] ﬂ Basic Person Demographics
=5 = (= Query 1
=0 ¢ Person Address City o o re]

4 Person Address Country Desc & Drop data |

4 Person Address Line 1
4 Person Address Line 2
J Person Address State Desc 25 -
{ Person Address Zip

1 Person Citizenship Desc
4 Person Ethnic 1 Desc

4 Person Ethnic Desc

4 Person Full Mame

d
i =rzon Gender S i

20

All Measures

|
4 Person ID
1 Person IPEI;JS Race/Ethnic 10
4 Person Marital Status Desc \
J Person Phone Extension \
1 Person Phone Number -~
{1 Person Phone Type Desc '_
4 Person Preferred Emai Address i
{1 Person Preferred Email Type Desc i 0
1 Person Preferred Name o o
Formatting Charts: InfoView
» Right-click the chart you wish to format.
= Select Format & Chart. Formet Chart x
H (Z2"T"'B Border | Appearance | Layout Pivot
= Complete the dialog box as needed. ‘ | | '
Name: Block2
Width: mcnes Height'mcha@
8
7 * Cut Cirl+X Display: Shew chart when empty Ayvoid duplicate row aggregation
G ™ . e Show chart title Show legend l:l
‘E 53 Copy 4 Show X Axis label
& e i Paste Ctri=v Show ¥ Axis label Show data values
g ¢ [ Format W[ chan D ook
g3 . I
{ 2 Filter 4 XELTH Background color: g -
1 Turn chart to...
0 Swap axis -
Sort » Georgia M
Order L FEOE S (2) More information
Align » Modify the chart format here
)< Remove Chart Del
ok |[ cancel [ appy |
Formatting Charts: Launch Pad TR R
. . Select chart area: | Chart block. ']
* Right-click the chart. pe—
| General Name: Block 1 =
= SeleCt Format Chal’t Area Display Width: 4,166 - |inches
. Region Type Height: 3.125 < |inches
= Complete the dialog box as needed. _
Data Values Display
10,000 - [ Palette style [] Avoid duplicate row agaregation
Background Show measure values with empty dimension values
Cut Cirl+X
8,000 - ok Y + Border [ Show dmension values with empty measure values H
C Cirl+C
» B copy Layout Shows measure values when value = 0
Pasth Ctrl+v
a 6,000 - m == ' Shows measure values for which the sum of values =0
‘: 2 Delete ] Fid
g ide always
E 4,000 - Turn Into 3 [] Hide when empty
Assign Data... [ Hide when following formula is true
- Formula
2,000 Linking 3 ‘ ", |
I , =
0 - r T T T T ol B
NI S Sort 3
h‘\to“‘&éuﬁ@oiﬁcw@”‘; e‘rﬁé‘ oo ‘éw .
o™ et Hide: 3 ]
Error and Warning
Person Address State Desc Order 3 = =
Align } OK Cancel
¢ Format Chart...




Adding Cells: InfoView
= Switch to Chart and Table Types.
» Click and drag the appropriate cell into the report.
= For a blank cell, double-click the cell to enter text.

Chart and Table Types

Insert

These elements are available to drop into your|
report

e

[=] Report Elements to Drag and Drop
Table Elements
Chart Elements
= ) cells ¥

= -_--;-.-."'-l-"h"" =

[T Dril Fiters =7

[] Last Refresh Date

] Document Name

] Query Summary

[ Prompt Summary

[ Report Fitter Summary

Page Number Cells LAIER

E’ E]lﬁl = B B C 34 I Report2

L RS-t

nt

Adding Cells: Launch Pad
= Select the Report Elements tab, then the Cell sub-tab.
= Toinsert a blank cell, click Blank and click in an open area of the report to insert the

cell.
=  Double-click the cell to enter text.

Report Elements ' Formatting |~ Data Access |~ Analysis |~ Page Setup |

Tables | Cell | Section | Chart | Other Took | Position |~ Linking |
1 Blank | Pre-Defined - il - o=k - =% Turn Into 5] Set as section

||:| Click to insert the cell here (Press ESC Key to cancel this an:tin:nn]l|

for mit 3¢ o |Sample Text

Sample Text




Editing Queries: InfoView
= Select Edit Query

» Make necessary edits to the query (add objects from universes, add filters, etc.)
» Run queries to update report results.

(7] Edit Query| < Refresh Data

X | [ Track ¥ 9n | G

BH | Q

E - [ﬁ Add Query ﬂ View SQL Query Properties.

| = Run Queryl ® ;ﬂ Close -

| Enter your search pattern here

Result Objects

J&a -

Perzon Other Award 3
Person Other Award 4
Person Other Award S
Person Other Award &
Person Prefix

Person Aod

Perzon Age Band

Person Alien Status
Person Alien Status Desc
Person Birth Country
Person Birth Country Desc
Person Birth Date

Person Birth Name Last

| Person Phone Number

| Person Phone Typ: Desc

| Person Phone Extens

b [¥ ][

Query Filters

4| i

@ Display by objects
() Dieplay by hierarchies

| Person Full Name Matches pattern - Enter Perzon Full Mame (u E}

4

Jaaa

(7 Query1

Editing Queries: Launch Pad
= Select the Data Access tab, then the Edit button under the Data Providers sub-tab.
» Make necessary edits to the query (add objects from universes, add filters, etc.)

» Run queries to update report results.

(1 Query Panel

2L o

Report Elements |

# Data Providers |

Data Access Analysis

" Data Objects '

(1 Edit

# purge +* | 5 Refresh -

e Mew Variable ~

PO OTEr AR
! Person Prefix
!
| Person Age Band
! Person Alien Status
! Person Alien Status Desc
| Person Birth Country
| Person Birth Country Desc
| Person Birth Date
! Person Birth Name Last
| Person Citizenship
! Person Citizenship Desc
! Person Deceased Date

| ! Person Ethnic
< m | b

(Giadoey - | [TEEE P E B

ijl Result Objects

! Person Gender

! Person Phone Extension | 4 Person ID

4
=

 Query Filters

! Person Full Namz | Matches pattern = | Enter Person Full Name: (use ' P28

f pata Preview

| Person Phone Mumber

b

2 Run Query ;ﬂ Close -

T X% 3
- -
' Person Phone Type Desc |]
! Person Full Name
§
X%~ ~[@=
it Refresh

| & query1
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» Launch Pad allows you to preview your report data when editing queries. Click on

the "Refresh” button on the Data Preview section to see the information that will be

displayed on your report.

(10 Query Panel

i
Fladdouery ~ | [EH = H E| 3 F 2 Run Query | &1 Close ~
T Universe outiine {71 Result Objects r X & W
a ™ -~
| Plescooecn | i ' Person Gender ! Person Phone Number ! Person Phone Type Desc I'g!
o8 - |1y Ev Bt < ;
| | | Person Phone Extension ! Person ID ' Person Full Mame
= '::‘ Colleague Core ODSR1_2
® || Refresh Date | Person Preferred Name 1 ! Person Citizenship Desc | ! Person Ethnic Desc | -
& [ H18 PIN ID :
[® [ ODS Dictionary 7 Query Filters X & -~
@ Academic Credentials
B | Academic Credentials -Major Informati | » ! Person Full Name | Matches pattern - || Enter Person Full Name (use 7 S
& ] Academic Credentials - Minor Informati|
# ] Institution &
= Institution Address
@ |1 Institution Attendance and Achievemel
@ |1 Academic Credential for Last Transfer |
| P = =
# 7] Institution Attendance for Last Transfe EEl Data Preview ' Refresh
e ferson Person Address Line 1 Person Address Line 2 Perzon Address City Person Address State Desc | Persor
@ Person Alternate Ids |
-
@ Person Address i
= Rooms 325-79TH STREET APT. 44 Morth Bergen New Jersey =
@[] Communication Management 176 WEST 24TH STREET Bayonne Mew Jersey
@ ] staff Information 216 BAYVIEW AVENUE APT #2 Jersey City Mew Jersey
121 63RD STREET AFT# B West New York Mew Jersey
53 DUNCAN AVEMUE APT, 5 Jersey City Mew Jersey
450 FTH STREET APT.4F Hoboken Mew Jersey
2 GLENWOOD AVENUE APT. B-1 Jersey City New Jersey
50 ARMSTRONG AVE. Jersey City Mew Jersey
280 HERDERSOM STREET APT, 14-B Jersey City Mew Jersey
222 GRAND STREET UNIT 4-C Hoboken Mew Jersey
84 Highland Ave #B1 Jersey City New Jersey
310 CENTRAL AVEMUE APT. 4 Jersey City Mew Jersey -
< [—— '
< | 1 | 3 Type & text to filter the values
| 7 query1

Scheduling Reports

»  Scheduling functionality remains similar between InfoView and Launch Pad. To
begin, right-click a report and select “Schedule”

InfoView

Launch Pad

Basic Person Demographics

Updated for 1.1 - What is the name

View Latest Instance

Properties
¥  Organization Basic Demographics .
Cateqgories
Updated for 1.1 - What is the name View

MOdiE

History
MNew

Add

Organize r

-!_! Basic Person Demographics

View

Properties

Maodify

| Schedule

Categories
Document Link
New >

Organize >

Send >

Details
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» The "Formats and Destinations” option in InfoView is now separated into two
separate options in Launch Pad, but the functionality remains the same.

InfoView

Schedule
Instance Title
Recurrence
Prompts
Formats and Destinations
Caching
Events
Scheduling Server Group

Formats and Destinations

¥ Output Format and Destination

Output Format

Output Format Details

[CIMicrosoft Excel
[Cladaobe Acrobat
[Fcomma Separated Values(CSV)

Destinations for Web Intelligence - Basic Person Demographics

Inbox [Z] File location [Z] FTP server [C] Email recipients

Schedule
Instance Title
Recurrence

Prompts

Caching
Events

Formats and Destinations

» Ouiput Format and Destination

Formats and Destinations

v Destinations Options and Settings

Scheduling Server Group

Destinations for the output

format Options and Settings
Inbox [T] use the Tob Server's defaults
Choose: Users -
Look For: H Search I
Available Recipients: Selected Recipients:
[aback ] I
Launch Pad
Schedule Formats
Instance Title
Recurrence
Output Format
Prompts 2 inati
73 Web Intelligence| Schedule Destinations
X Destination:
DMlcrosnft Excel Instance Title
Cachi BI Inbox -
aching
DAdDbE Acrobat Recurrence Keep an instance in the history
Events DCnmma Separated Prompts [] Use default settings
Scheduling Server Group Formats Available Recipients:
o Caching of 2+ Find tite ™
Destinations L > M
Events
Scheduling Server Group m D
(- I“_"éGroup List &
&
&
&
‘8
&
E]
I‘%
&
]
Target Name:
(@) Use Automatically Generated Name
(7 Use Specific Name
Send As:
(7 Shortout 32
@ Copy




Creating New Reports: InfoView

= To create a new Webl document in InfoView, select “New" from the Menu and then

select "Web Intelligence Document.”
* Then select the Universe from which you would like to build your report.

SAP BUSINESSOBJECTS INFOVIEW Web Intelligence Document - New Document

: [0 | Universe «
@Home Document List | Open = | Send To -~ | D

Colleague Core Dashboard R1

W36 Colleague Core ODS R1_2

IE% 2 | |New|~| Add ~ | Organize ~ | Actions
=- All &L Hyperlink

" m 4 InfoView Page Layout

E tnbos (@ Publication

V36 Colleague Courses and Faculty ODS R1_2

W o Ho

V36 Colleague Student ODS R1_2

- [ pybli 4| Desktop Inteligence Document

+#  Web Inteligence Document

~§* Voyager Workspace
Analytic

==

55 Corporate Dashboard

Category

Falder

E W

= Build your report by dragging objects from the universe into the Result Objects in the

Edit Query Panel. Once you have set the objects and any appropriate filters, click
“Run Query” to generate the report.

New Web Intelligence Document S,
[ M -| 68| M- ||3 Edit Query| (@ Edit Report & Run Query B| @ | @ -
| B|E| 5 | G Add Query| | Em | i

__ " Data i E’roper‘ties-i Result Objects vTHXW

olleague Core OD5 R1_2 4 ||| Toinclude data inthe report, select objects in the Data tab and drag therm here, Click Run Query to return the data to the
F’ Refresh Date [Tl report.
i @ Database Refresh Date
[ H18 PINID

[#-[7 ODS Dictionary =
[ 7] Academic Credentials

[ Academic Credentials - Mz
i) Academic Credentials - Mil—
i) Institution

[ Institution Address : - "
[ 7] Institution Attendance and Qucty Filter |BaXx J@

[#-{E7] Academic Credential for Le _ ||| Tofilter the query, drag predefined filters here ar drag objects here then use the Filter Editor to define custorn filters,

€| i1 | 3

@ Display by objects
(") Display by hierarchies

— _ I
. (H Query1 | 4 b E
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Creating New Reports: Launch Pad
» To create a new Webl document in Launch Pad, select “"Applications” from the upper
right hand menu pane, then click "Web Intelligence Application”.
* A new tab will open. Select the “New" icon from the toolbar.
* From the “Create a new data provider” window, select “Universe” and click OK.

Create a new data provider x

Applications ¥  Preferences  Help Menu = Log Off
3" Anabysis edition for OLAP

D BEx Web Applications ry Mo data source
Create an empty document

Select a data source

“,‘: BI workspace

Crystal Reports for Enterprise s, Universe
/> Cre """ Select a universe as a data source
™ Module

) Web Inteligence Application Jkat

Home | Documents | Web Intelligence =~ += &

; . I G im e —
Web Inteligence ™ S | B | oK | Cancel

» Then select the Universe from which you would like to build your report.

= Build your report by dragging objects from the universe into the Result Objects in the
Query Panel. Once you have set the objects and any appropriate filters, click “Run
Query” to generate the report.

Universe |

. T Query Panel ¢
Select a universe for the qu{ = ot w
DJ Add query ~ | [ H & 19 | 2 Run Query ,ﬂ] Close ~
Available Universes:
M ¥ Universe outline {10 Result Objects
ame -~
Atti‘u'ity' Master perspective = o
Colleague Advancement OF | €@ - |1ype fere to fiter on 4 T
Colleague Core ODSR1. 2|
g 7 -
Colleague Courses and Fad | & % FREEZE_20110914 Colleague Student pee

# || Customized Data
=] Students

=] Student Terms
=) Student Education Plans

=] Academic Programs =
£ Academic Program Locations -

# || Tests and Non Course Activities

= Student Cohort Groups

£ Student Programs

= All Student Programs

Colleague Finance ODS R =
= . S =i ! Query Filters X | ~ v [E

2] Student Program Majors fH Data Preview ! Refresh
£ Student Program Minars

] Student Enrollment

[# Student Program Specializations

£ Student Program CCDs

&l =71 Shident Ranm Ascinnments =5

4 | n | 13 Type a text to filter the values

Lj— Query 1 //
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